
NI INSIGHT
Projecting Measured or Simulated Data onto 3D Models

NI INSIGHT

January 2007
374560A-01 



Support

Worldwide Technical Support and Product Information

ni.com

National Instruments Corporate Headquarters

11500 North Mopac Expressway Austin, Texas 78759-3504 USA Tel: 512 683 0100

Worldwide Offices

Australia 1800 300 800, Austria 43 0 662 45 79 90 0, Belgium 32 0 2 757 00 20, Brazil 55 11 3262 3599, 
Canada 800 433 3488, China 86 21 6555 7838, Czech Republic 420 224 235 774, Denmark 45 45 76 26 00, 
Finland 385 0 9 725 725 11, France 33 0 1 48 14 24 24, Germany 49 0 89 741 31 30, India 91 80 41190000, 
Israel 972 0 3 6393737, Italy 39 02 413091, Japan 81 3 5472 2970, Korea 82 02 3451 3400, 
Lebanon 961 0 1 33 28 28, Malaysia 1800 887710, Mexico 01 800 010 0793, Netherlands 31 0 348 433 466, 
New Zealand 0800 553 322, Norway 47 0 66 90 76 60, Poland 48 22 3390150, Portugal 351 210 311 210, 
Russia 7 495 783 68 51, Singapore 1800 226 5886, Slovenia 386 3 425 42 00, South Africa 27 0 11 805 8197, 
Spain 34 91 640 0085, Sweden 46 0 8 587 895 00, Switzerland 41 56 200 51 51, Taiwan 886 02 2377 2222, 
Thailand 662 278 6777, Turkey 90 212 279 3031, United Kingdom 44 0 1635 523545

For further support information, refer to the Technical Support and Professional Services appendix. To comment 
on National Instruments documentation, refer to the National Instruments Web site at ni.com/info and enter 
the info code feedback.

© 2007 National Instruments Ireland Resources Limited. All rights reserved.



 Important Information

Warranty
The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects 
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National 
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives 
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be 
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any 
equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by 
warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In 
the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document 
without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. In no event shall National 
Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL 
INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING 
FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of 
the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against 
National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in 
performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service 
failures caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of the 
product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside 
reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other 
intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only 
to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section 
on ni.com/legal for more information about National Instruments trademarks.

Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Members of the National Instruments Alliance Partner Program are business entities independent from National Instruments and have no agency, 
partnership, or joint-venture relationship with National Instruments.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE 
COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, 
TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR 
ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER 
COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF 
HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY 
UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, 
THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, 
INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS 
CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION 
DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT 
EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY 
RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER 
NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT 
LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



© National Instruments Ireland Resources Limited v NI INSIGHT

Contents

About This Manual
Writing Conventions......................................................................................................  vii
Related Documentation..................................................................................................  viii

Chapter 1
Getting Started with NI INSIGHT

Creating Scenes with 3D Models...................................................................................1-1
Analyzing Scenes with 3D Models................................................................................1-3

Zooming and Rotating the Model....................................................................1-4

Chapter 2
Creating and Evaluating Scenes

Creating 3D Projections.................................................................................................2-1
Saving Scenes, Presentations, and Layouts.....................................................2-2

Working with Models, Test Data, Videos, and Graphics ..............................................2-3
Models .............................................................................................................2-3

Defining Display Modes ...................................................................2-4
Changing the Perspective..................................................................2-5
Creating Information Nodes..............................................................2-5

Measurement Data...........................................................................................2-6
Videos..............................................................................................................2-7
Graphics...........................................................................................................2-8

Chapter 3
Preparing Models and Data and Displaying Measured Values Online

Providing Measurement Data in DAT Format ..............................................................3-1
Generating Suitable VRML Models ..............................................................................3-2
Creating Online Projections...........................................................................................3-3

LabVIEW INSIGHT Connectivity VIs ...........................................................3-3

Appendix A
Technical Support and Professional Services

Index



© National Instruments Ireland Resources Limited vii NI INSIGHT

About This Manual

You can use this manual to familiarize yourself with NI INSIGHT features 
and how to use them.

The first chapter describes how to map measurement data onto a 3D model 
in a few easy steps. Each exercise contains diagrams that illustrate the steps 
involved. 

The second chapter describes how to create 3D projections and how to 
work with models, measurement data, videos, and graphics. You will also 
learn how to save scenes, presentations, and layouts for reuse later.

The third chapter describes how to prepare data and models for use in 
NI INSIGHT and how to display data during measurements in other 
applications, such as LabVIEW and DIAdem, in NI INSIGHT.

Writing Conventions
The following conventions are used in this manual:

<> Angles brackets indicate a key you press to perform a function, for 
example, <Ctrl> for the control key.

» The » symbol leads you through nested menu items and dialog box options 
to a final action. If you read File»Print»Printer, you open the File menu, 
select the menu item Print, and select Printer in the dialog box that opens.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Parameters are also bolded.

italic Italic text denotes variables, emphasis, cross-references, or an introduction 
to important concepts. Italic text also denotes text that is a placeholder for 
a word or value that you must supply.
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monospace Text in this font denotes text or characters that you should enter from the 
keyboard, such as sections of code, programming examples, and syntax 
examples. This font is also used for the proper names of disk drives, paths, 
directories, programs, subprograms, subroutines, device names, functions, 
operations, commands, variables, controls, events, methods, filenames, and 
extensions.

monospace bold Bold text in this font denotes the messages and responses that the computer 
automatically prints to the screen. 

Related Documentation
For more detailed information on NI INSIGHT, refer to the following 
documentation:

• NI INSIGHT Help, which you open by clicking Help»Contents, 
or by pressing <F1>.
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1
Getting Started with NI INSIGHT

NI INSIGHT is the National Instruments software for mapping 
measurement data and simulation data onto 3D models. With NI INSIGHT 
you display temperatures as color shading on a crash test dummy, for 
example, or you display strain on bridge elements as deformation. Using a 
three-dimensional model of the test object and the measured or simulated 
data, you link each signal to the associated model point. For model points 
at which no sensor was mounted, NI INSIGHT interpolates the values from 
the data of neighboring model points. To inspect the model from all sides, 
you can shift, rotate, and zoom the model in all directions.

You can run an evaluation automatically or inspect specific times or 
time segments more closely. You move the crosshair cursor along the 
measurement curves in the axis system for a more detailed view. For each 
point, NI INSIGHT displays the projection of the data onto the model. You 
also can define several model windows with the same model in one 
evaluation, to compare different perspectives or test results. 

Parallel to the data projection, you can run a video recording of the test, 
to evaluate the measurement results and the test synchronously. This shows 
you at a glance, which test situation led to which result.

Creating Scenes with 3D Models
In the following exercise you link temperature signals to the model of a 
metal plate that has temperature sensors mounted at regular intervals. 
To assign data to the model, complete the following steps.

1. Start NI INSIGHT. 

A prepared layout appears in the workspace with a model area, a data 
area, and a graphic area. In the data window on the right, you see the 
various NI INSIGHT file types that you use to create scenes with 
models, measurement data, and axis systems, in the workspace. 

2. Click the Model files tab in the data window.

3. Drag and drop plate.mod into the model area of the layout.

4. Click the DIAdem data files tab in the data window.
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5. Click + to open the plate data set. 

6. Drag and drop the data channel Temp_1 to a model point on a grid line 
intersection. The model points are indicated by circles on the grid line 
intersections.

Note If you do not link the channel precisely to a model point, NI INSIGHT prompts 
you to assign the channel again. You can zoom the model to see the model points better, 
as described in the section on Zooming and Rotating the Model. 

7. Select Color in the Display data as dialog box.

8. Click OK.

9. Repeat steps 6–8 to link the channels Temp_2, Temp_3, and Temp_4 
to any model points.

Complete the following steps to display data as curves in the axis system 
and to insert a diagram of the test in the layout.

1. <Ctrl>-click the channels Temp_1, Temp_2, Temp_3, and Temp_4.

2. Drag and drop the channels into the axis system area.

3. Click the Graphic files tab in the data window.

4. Drag and drop plate.jpg into the graphic area. 

DIAdem INSIGHT displays a scene similar to the following figure.

Figure 1-1.  NI INSIGHT Links Temperature Signals to a 3D Model.
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5. Click Save to save the scene as Test. 

A scene links the created layout to the model, to the data set, and to the 
graphic.

Analyzing Scenes with 3D Models
Once you have created the scene, you can compare the measurement data 
with the model simulation. 

To run and then manually evaluate the curve display and the data 
projection, complete the following steps:

1. Click Play once to run the whole evaluation.

2. Click Play continuously to run the video repeatedly.

3. Move the speed slider to change the playback speed.

4. Click Stop to stop the repetitions.

5. Click and drag the crosshair cursor in the axis system, for a more 
detailed examination.

NI INSIGHT synchronizes the model display and the video with the 
axis system and displays the evaluation with the crosshair cursor, 
as shown in the following figure.

Figure 1-2.  Projection of Temperature Data on 3D Model.
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Zooming and Rotating the Model
At any stage, you can rotate and zoom the model in the model window.

• Click and drag the left mouse button to rotate the model.

• Click and drag the right mouse button to zoom the model. You must 
move the mouse horizontally.
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2
Creating and Evaluating Scenes

Project measured or simulated data as color shading or as deformation, onto 
a model of the test object, with NI INSIGHT. You load a grid model of the 
test object and you link the signals to the grid points on the 3D model. You 
can move and zoom the model to view it from all sides. 

Parallel to the data projection, you can run a video recording of the test, 
to evaluate the measurement results and the test synchronously. You can 
integrate graphics into the scene for more clarity.

Creating 3D Projections
By default, the workspace in DIAdem INSIGHT displays a prepared layout 
with a model area, an axis system area, and a graphic area. The data 
window to the right of the workspace in NI INSIGHT organizes model 
files, measurement data files, graphics files, and video files. 

The 3D model of the test object is the key element of the NI INSIGHT 
scenes. 3D models consist of numerous grid points. Connect the grid 
points, which represent sensor positions, to the measurement data from the 
individual sensors. NI INSIGHT displays the measured data on each grid 
point as shading or as deformation. To display the same measurement data 
as curves, drag and drop the data channels that are selected in the data 
window into the axis system. 

To evaluate the effects of air conditioning on a car driver, for example, drag 
and drop each measured temperature channel onto the grid point of the 
dummy model, where the corresponding temperature sensor was mounted. 
Select Color as the display type.

Use the player functions on the NI INSIGHT toolbar for an overview of the 
climate test. NI INSIGHT processes the entire time channel and displays 
the temperatures on the dummy, in color. Red tones indicate warm areas 
and blue tones indicate cool areas. You use the slider control to regulate the 
speed of the evaluation display.
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To inspect specific times or time segments more closely, use the crosshair 
cursor in the axis system. You can move the crosshair cursor from point to 
point in your graph to check critical or unclear ranges. For example, if an 
unexpected result occurs in the test, move the crosshair cursor to this time. 
NI INSIGHT displays the temperature distribution at this time, on the 
dummy model.

You can rotate and zoom the model while you create a scene and during an 
evaluation. To rotate a model, click and drag the mouse. To zoom a model 
in or out, right-click and drag horizontally. To move the model along a 
coordinate axis, right-click and simultaneously press <x>, <y>, or <z> for 
the relevant coordinate axis.

To resize or to move an area in the workspace, click the inside edge of the 
area. NI INSIGHT displays the selected area with a frame and square 
markers. Drag the black markers to resize the area. Drag the frame to 
reposition the area. Press <Del> to delete the selected area. 

To add an area, drag and drop the model, the data set, the video, or the 
graphic, from the data window into the workspace. NI INSIGHT creates 
the associated area type and displays a model in a model area, displays data 
as a curve in an axis system, displays a video file in a video area, and 
displays a graphic in a graphic area. Each area can display only one file.

Saving Scenes, Presentations, and Layouts
When you save a scene, NI INSIGHT saves the evaluation layout and the 
links to the data files, model files, and graphic files used. The layout file 
has the filename extension cis. If you reload this scene, the data files, the 
model files, and the graphic files must be located in the folders that are 
shown in the file window.

If you save the scene as a presentation, you can demonstrate an evaluation 
on another computer. A presentation file combines all data files, video files, 
and picture files into a single CIP file. To save a presentation, select 
File»Save as and select Presentation (cip) as the file type. You also can 
password-protect a presentation to prevent alterations. Use the NI  CLIP-
INSIGHT Player to run presentations on computers on which NI INSIGHT 
is not installed. 

You can load the layout as an empty template for evaluations of similar 
tests. A layout specifies only the type and the number of areas, including 
their size and position. To save the layout of the current scene in the layout 
library, select File»Save layout. To load a layout, select File»Open layout 
to open the layout library. 
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Working with Models, Test Data, Videos, and Graphics
The data window to the right of the workspace in NI INSIGHT lists folders 
with the available model files, measurement data files, video files, and 
graphics files, on various tabs. To add folders to the data window, select 
New directory from the shortcut menu of the tab. To delete a folder from 
the data window, right-click the folder and select Delete from the shortcut 
menu.

Models
NI INSIGHT projects data onto VRML models (wrl), which you can 
export with most CAD/CAE programs. You can use the VRML Optimizer 
to prepare the models for display in NI INSIGHT. Refer to the section on 
Generating Suitable VRML Models in the next chapter, for more 
information about creating and editing VRML models.

You can display data on a model as color shading, as deformation of the 
model surface, or as resizing of the model points. Use the Color display 
mode to display temperature changes as color shading on the model. Use 
the Deformation display mode to display movements of the model surface. 
If you assign a data channel to a point that already has data assigned to it, 
NI INSIGHT applies the new data channel. 

You can combine display types on one model. For example, you can display 
temperature simultaneously as color shading and as deformation. To do 
this, assign the same data channel twice to one model point, with a different 
display mode each time. The ToolTip for a point shows which display type 
and which data channel you defined for a point.

To assign a data channel to several model points, press <Ctrl> and drag 
open a rectangle over the model points. Then drag and drop the data 
channel onto the selected model points. To delete the selection marking, 
select Delete selection from the shortcut menu of the model. 

You can simplify the assignment of multiple data channels to multiple 
model points. Name the points in a model to match the channel names of 
the measurement data. Right-click the model point to rename it, and select 
Point info from the shortcut menu. Enter the name of the data channel. 
If you drag and drop the entire data file onto the model, NI INSIGHT 
automatically assigns the data channels to the matching model points.
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If you have several different data files for the same model, you do not need 
to reassign the data channels to the model each time you load a new data 
set. As long as the data channels are in the same order in all the data sets, 
the channel assignment to the model points remains the same.

You can find a model point using its coordinates. To do this, right-click in 
the model area and select Find point from the shortcut menu. Enter the 
coordinates. NI INSIGHT displays the name of the model point that is at, 
or is closest to, these coordinates.

To delete the channel assignment of a model point, select the Signal 
assignment deletion button shown on the left, from the shortcut menu of 
the model point. To delete the assignment for several points, press <Ctrl> 
before you delete, and drag a rectangle around the model points.

Defining Display Modes
In the model area you can specify the display and the lighting of the model. 
Select Display from the shortcut menu to alter the settings for color 
shading, deformation, and size. 

For the Color display mode, you use the settings Surfaces and Color on 
the Structure tab to specify the shading and you use the settings Points and 
Edges to specify the display of the model points. For the definition of a 
rigid body shift you can display the local coordinate systems.

You specify the Deformation display mode as shift or as rotation in the 
x-direction, the y-direction, or the z-direction, with a positive or a negative 
sign. To display even minor deformations, you can use the Factor to set 
the magnification of a shift. Use Weighting to specify the interpolation 
method for model points without measurement data. NI INSIGHT 
calculates the deformation behavior of these model points from the data 
of the neighboring measurement points. 

The display mode Size displays measurement data as the extent of a circle 
point or as the height of a column in the x-direction, the y-direction, and 
the z-direction, on the model point. Use the size display, for example, 
to display local pressure changes as the extent of a circle surface. 

To define the brightness of the display and additional light sources, select 
Lighting and Light sources from the shortcut menu of the model area. 
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Changing the Perspective
At the bottom right in the model area, you see a small coordinate system 
that shows the position of the model in space. You can use the shortcut 
menu of the coordinate system to rotate the model directly in a 2D view. 
Click XY-plane for a view from the top of the model, and click XZ-plane 
or YZ-plane for one of the side views of the model. Click Perspective to 
redisplay the last 3D view.

You can save different camera perspectives of the model and view them 
individually. You can run an evaluation in each camera position to view 
details from various perspectives. To change the camera position, 
select Next camera from the shortcut menu of the coordinate system. 
NI INSIGHT saves the last model position as Camera1. Rotate and zoom 
the model for a new setting. You can create up to ten different camera 
positions. The coordinate system shows you which camera view 
NI INSIGHT is displaying. Click Next camera and Previous camera 
to switch camera positions. 

Creating Information Nodes
For each model point you can create a description and you can link the 
description to the model point. Save the description in HTML format in 
the INSIGHT\INFO folder. To link the HTML page to a model point, 
right-click the model point. Select Point info from the shortcut menu and 
enter the name of the HTML file, without the path or filename extension, 
instead of the point name.

If you now position the mouse on the information node, NI INSIGHT 
displays the description on the Info tab of the data window, as shown in the 
following figure.
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Figure 2-1.  Description for a Model Point in the Data Window.

Measurement Data
NI INSIGHT works with measurement data and simulation data that are in 
the DIAdem DAT format. To use data in other formats in NI INSIGHT, 
you must save the data in DAT format in DIAdem NAVIGATOR, or 
use the DIAdem Connectivity VIs to save the data in DAT format in 
LabVIEW. Refer to the section on Providing Measurement Data in DAT 
Format in the next chapter for more information about converting data.

If you add a data file or a data channel to an axis system, NI INSIGHT uses 
the time channel of this data file as the x-channel. If this data file contains 
multiple time channels, select the x-channel you want to use. A downwards 
arrow appears in front of the x-channel. First select the x-channel and then 
the y-channel, which is indicated by an arrow to the left.

Each axis system has a legend, which you can display by selecting the 
Legend on/off button shown on the left, from the shortcut menu. The 
squares in the legend are the same color as the curves they represent. 
NI INSIGHT displays as many squares as the current height of the axis 
system allows. When you click a square, the associated curve appears 
dashed. The ToolTip indicates which data channel the curve represents. 
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To delete a curve from the axis system, select the curve symbol and press 
<Del>. 

NI INSIGHT scales the y-axis to the value range of all data channels 
and the x-axis to the value ranges of the time channels. Use Scale to 
extract/Curve to zoom sections in the y-direction and use Zoom on/off 
to zoom time segments.

Videos
NI INSIGHT works with video files in AVI format and MPEG format, 
the same as DIAdem CLIP and DIAdem VIEW. 

Each video area contains only one video. When you drag and drop a new 
video into the video area, NI INSIGHT replaces the old video with the new 
one. Create additional video areas to compare videos. You can zoom parts 
of a video to inspect details more closely. 

NI INSIGHT synchronizes videos and curves using the time channel of the 
data set and the frame rate of the video. If the data acquisition rate is higher 
than the frame rate, NI INSIGHT displays the same video frame for several 
measured values. For example, if the data acquisition rate is 100 kHz and 
the video frame rate is 1,000 frames per second (1  kHz), the video frame 
changes at every 100th curve point.

If you have started and stopped the video recording and the measurement 
separately, you must specify the time segment during which the measured 
data overlaps with the videos. In NI INSIGHT, the time range you specify 
is called the Active segment. NI INSIGHT only displays changing video 
frames as shown in the following figure, when you move the crosshair 
cursor inside the active time section in the axis system.

To enter the beginning and the end of the active segment, select the 
Synchronization parameters button shown on the left, from the shortcut 
menu of the video area. With the Apply cursor position button, you can 
use the position of the crosshair cursor in this dialog box to specify the start 
time of the video or the beginning and the end of the active segment.
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Figure 2-2.   Evaluation of a Crash Test.

When you evaluate a scene using the player bar, use the metronome shown 
on the left to specify whether NI INSIGHT runs the entire video or the 
entire time axis of the axis system. If you drag and drop the metronome 
onto a video area, NI INSIGHT plays the entire video and the crosshair 
cursor follows inside the active segment of the axis system. If you drag and 
drop the metronome into the axis system, the crosshair cursor follows along 
the entire length of the axis system and the video plays only the active 
segment.

Graphics
Use graphics to include a diagram of a test stand or to insert a company logo 
into your presentation. You can load graphics in common formats. Each 
graphic area contains one graphic, which you also can zoom. 



© National Instruments Ireland Resources Limited 3-1 NI INSIGHT

3
Preparing Models and Data and 
Displaying Measured Values Online

Before you can use NI INSIGHT to project data onto models, the data must 
be in the DIAdem DAT format and you must prepare suitable VRML 
models.

Other applications, such as LabVIEW and DIAdem, can communicate with 
NI INSIGHT to project data onto models during a measurement.

Providing Measurement Data in DAT Format
Your data must be available in DAT format if you want to project the data 
onto a model with NI INSIGHT. DIAdem and LabVIEW can both save 
data in DAT format.

By default, DIAdem saves data in TDM data format. DIAdem can load any 
data format for which a DataPlugin is registered. The Save as dialog box 
offers the DAT format and other data formats, as file types for exporting 
data. 

Use the LabVIEW DIAdem Connectivity VIs to save data in DAT format 
with LabVIEW. These VIs can save data in DAT format or transfer the 
acquired data to the DIAdem Data Portal. The LabVIEW DIAdem 
Connectivity VIs are available at the National Instruments Web site.

The DAT format saves the data properties in a separate header file in the 
text format with the filename extension dat and saves the numeric data in 
the binary format that takes up the least amount of space for that particular 
data. One data set can include several binary files, for example, files with 
the filename extension w16 or r64.
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Generating Suitable VRML Models
Nearly all CAD/CAE packages allow for the export of 3D models to 
VRML 2.0 (wrl) format. Most of these programs also have some limited 
mesh generation capabilities, meaning that the package automatically 
creates a simple mesh for the VRML. The quality and density of this mesh 
determines how well this VRML file will work in NI INSIGHT.

If you generate a VRML model, the mesh model should meet the following 
criteria: 

• A uniform mesh with no severely elongated polygons.

• A mesh without multiple surfaces.

• A mesh with nodes that are dense enough to display the details that you 
want to show. This depends on how detailed your model is and how 
many measurement points you want to display. 

The surface of the VRML file is composed of triangles or squares. 
Elongated polygons are a common problem for most CAD/CAE 
applications. If these triangles or squares are elongated, thus not mostly 
uniform, any interpolation scheme will be distorted by the mesh. The 
interpolation schemes normally use the distance between points or nodes 
along the connecting lines for distance calculations. Many of the 
CAD/CAE packages support functions to add “split lines” or additional 
points that can be used in the creation of the mesh. Many programs also 
have support for controlling the density of the mesh. Using these tools can 
eliminate most elongated polygons.

Some CAD/CAE packages generate double surfaces for a single area when 
they generate the model, especially for thin-walled bodies. When you 
convert the model into a VRML file, these double surfaces distort the 
display and make it difficult to select the correct grid point. Some 
CAD/CAE packages have controls for what surfaces are used when you 
create your VRML model. NI INSIGHT also comes with an Optimizer tool 
for VRML files which eliminates most multiple surfaces. 

Occasionally a CAD/CAE package will not create VRML 2.0 files but 
VRML 1.0. Others are supposed to create VRML 2.0 files but do not create 
them correctly or use some sort of non standard format for the VRML file. 
These files will often not display or will display incorrectly in 
NI INSIGHT. There are third party tools that can be used to convert from 
VRML 1.0 and sometimes from non standard VRML to VRML 2.0.
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Some CAD/CAE programs cannot create VRML models with suitable 
mesh. In these cases there are often add-on tools to the CAD/CAE package 
or third party tools that can be used to generate a better mesh. Another 
option is to save the model in another format, such as Stereo Lithography 
(STL), and convert to VRML using a third party model conversion utility. 
This will often result in a cleaner model in some CAD/CAE packages.

Note The National Instruments Web sites have step-by-step instructions on how to use the 
common CAD/CAE software packages to create VRML models that are suitable for 
NI INSIGHT.

Creating Online Projections
You can open NI INSIGHT from another application, such as LabVIEW 
or DIAdem, to project data onto a model of the test object during the 
measurement.

LabVIEW INSIGHT Connectivity VIs
With the LabVIEW INSIGHT Connectivity VIs you can launch 
NI INSIGHT from LabVIEW, to project measurement data on 3D models 
online. The wizard helps you to link model points to the measurement data. 
You select a scene from NI INSIGHT, specify the data sources from 
LabVIEW, and link model points to the channels of the data source. You 
specify the display mode for each channel, as shown in the following 
figure. You must then define a measurement that writes the measurement 
data to the data channels. 
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Figure 3-1.  The Wizard Links Measurement Data to Model Points. 

During a measurement, you can change the settings for the display modes 
Color and Deformation, for single model points. To do this, you use the 
point number or the coordinates of the model point.
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A
Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at 
ni.com for technical support and professional services:

• Support—Online technical support resources at ni.com/support 
include the following:

– Self-Help Resources—For answers and solutions, visit the 
award-winning National Instruments Web site for software drivers 
and updates, a searchable KnowledgeBase, product manuals, 
step-by-step troubleshooting wizards, thousands of example 
programs, tutorials, application notes, instrument drivers, and 
so on.

– Free Technical Support—All registered users receive free Basic 
Service, which includes access to hundreds of Application 
Engineers worldwide in the NI Discussion Forums at 
ni.com/forums. National Instruments Application Engineers 
make sure every question receives an answer.

For information about other technical support options in your 
area, visit ni.com/services or contact your local office at 
ni.com/contact. 

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, National Instruments 
Alliance Partner members can help. To learn more, call your local 
NI office or visit ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact 
your local office or NI corporate headquarters. Phone numbers for our 
worldwide offices are listed at the front of this manual. You also can visit 
the Worldwide Offices section of ni.com/niglobal to access the branch 
office Web sites, which provide up-to-date contact information, support 
phone numbers, email addresses, and current events.
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